
 

QU I CKB OOKS  2 0 16  ST U DENT  GU I D E  

Lesson 12 

Doing Payroll with QuickBooks 
 



 

 

Copyright 

Copyright 2016 Intuit, Inc. Intuit, Inc. 

All rights reserved. 5601 Headquarters Drive 

 Plano, TX 75024 

Trademarks 

©2016 Intuit Inc. All rights reserved. Intuit, the Intuit logo, Intuit ProLine, Lacerte, ProAdvisor, 

ProSeries and QuickBooks, among others, are trademarks or registered trademarks of Intuit Inc. in 

the United States and other countries. Other parties’ marks are the property of their respective 

owners. 

Notice to Readers 

The publications distributed by Intuit, Inc. are intended to assist accounting professionals in their 

practices by providing current and accurate information. However, no assurance is given that the 

information is comprehensive in its coverage or that it is suitable in dealing with a client’s particular 

situation. Accordingly, the information provided should not be relied upon as a substitute for 

independent research. Intuit, Inc. does not render any accounting, legal, or other professional advice 

nor does it have any responsibility for updating or revising any information presented herein. Intuit, 

Inc. cannot warrant that the material contained herein will continue to be accurate nor that it is 

completely free of errors when published. Readers should verify statements before relying on them. 



Lesson 12 — Doing Payroll with QuickBooks Table of Contents 

QuickBooks 2016 Student Guide 3 

Table of Contents 

Lesson Objectives .............................................................................................................................. 4 

Setting Up for Payroll .......................................................................................................................... 5 

Setting Up Employee Payroll Information .............................................................................................. 8 

Using Employee Defaults to Store Common Information ........................................................................ 9 

Setting Up Payroll Schedules ............................................................................................................ 10 

Adding a New Employee ................................................................................................................... 13 

Running a Payroll Schedule ............................................................................................................... 15 

Viewing the Paycheck ....................................................................................................................... 18 

Printing Paychecks after Leaving Pay Employees Window ................................................................... 19 

Printing or Emailing Pay Stubs after Leaving Pay Employees Window ................................................... 20 

Paying Payroll Taxes ......................................................................................................................... 22 

Writing a Check for Payroll Taxes ....................................................................................................... 23 

Doing Payroll with QuickBooks — Review Questions .......................................................................... 25 

Review Activities ............................................................................................................................... 26 

Answers to Review Questions ........................................................................................................... 27 



Lesson 12 — Doing Payroll with QuickBooks Lesson Objectives 

QuickBooks 2016 Student Guide 4 

Lesson Objectives 

 To gain an overview of payroll in QuickBooks 

 To learn more about payroll setup 

 To set up employee payroll information 

 To set up payroll schedules 

 To practice writing and printing a payroll check 

 To learn how QuickBooks tracks your tax liabilities 

 To practice paying payroll taxes 
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Setting Up for Payroll 

By default, the QuickBooks payroll feature is turned on. Keep in mind that you must subscribe to one of the available 

QuickBooks Payroll services that work with QuickBooks Desktop in order to run payroll in QuickBooks. However, you 

can test out the features of QuickBooks Payroll using one of the sample companies such as Rock Castle 

Construction. Do not use this feature for actual payroll as the rates are not accurate. 

If you want to turn off payroll in your company file, follow the procedure below. 

 To turn payroll off in a company file: 

 Make sure you are signed in to the QuickBooks company as the Admin user. (If other users have been set up on 1.

other computers to access the company in multi-user mode, ensure that they are not signed in and that you are 

in single-user mode.) 

 From the Edit menu, choose Preferences then click Payroll & Employees in the left panel. 2.

 Click the Company Preferences tab and select No payroll. 3.

 Click OK. 4.

QuickBooks maintains a list for everything that affects the amount on a payroll check and for every company expense 

related to payroll. This list is called the Payroll Item list. There are payroll items for compensation, taxes, other 

additions and deductions, and employer-paid expenses. QuickBooks uses payroll items to track individual amounts 

on a paycheck, and accumulated year-to-date wage and tax amounts for each employee. 

Payroll items affect either Payroll Liabilities or Payroll Expenses on the Chart of Accounts by default (unless you make 

changes to their setup). However, you will be able to run detailed reports related to Payroll based on the payroll items 

and how they are used in paychecks and payroll liabilities payments. 
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 To view the Payroll Item list: 

 From the Employees menu, choose Manage Payroll Items then choose View/Edit Payroll Item List. (You must 1.

have payroll turned on to see this choice.) 

 

 Close the Payroll Item List. 2.

 NOTES 
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If you need to add a payroll item after you’ve set up payroll in QuickBooks, you can use the following procedure. 

 To add a payroll item: 

 From the Employees menu, choose Manage Payroll Items then choose New Payroll Item. 1.

 Select Custom Setup then click Next. 2.

 QuickBooks displays the Add new payroll item window, which steps you through the payroll item setup process. 3.

 

 Select the type of payroll item you want to create then click Next. 4.

QuickBooks will open the Payroll Setup window. 

 Follow the onscreen instructions to create the payroll item. 5.

 When you are done, click Finish. 6.

 Close the Payroll Item list. 7.

 NOTES
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Setting Up Employee Payroll Information 

QuickBooks calculates payroll for each employee on the basis of that employee’s pay rate, marital status, 

exemptions, and so on. The Employee list stores general information about each employee as well as payroll 

information. 

 To view information stored in the Employee list: 

 Click Employees on the icon bar to open the Employee Center. 1.

 Select the employee you wish to view from the list and then right-click, select Edit Employee. 2.

 Click the Address & Contact tab to enter the employee’s address, phone number, and emergency contact 3.

details. 

 Click the Additional Info tab to access the employee id or account number, billing rate level, and custom fields. 4.

 Click the Payroll Info tab. This is where you set up the employee pay schedule, additions, deductions, and 5.

company contributions.  

 Use the buttons on this tab to access additional information for direct deposit, taxes, and sick/vacation pay. 6.

 

 Click OK to return to the Edit Employee window from the additional information boxes. 7.

 Click OK again to return to the Employee Center.8.
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Using Employee Defaults to Store Common Information 

QuickBooks stores a wealth of information about each employee, but it doesn’t require you to enter the same 

information over and over. When you have information that applies to most of your employees, you can enter it into 

your employee defaults. Then when you add an employee, QuickBooks automatically fills in the information stored 

with the defaults. You just need to add or change any information that is different for a particular employee. 

 To view employee defaults: 

 From the Employee Center, choose Change New Employee Default Settings from the Manage Employee 1.

Information menu button. 

 

 Set the default pay schedule, earnings items, etc. from the window. 2.

 Use the Taxes button to set up the default state/federal tax settings. 3.

 Click OK to close the Taxes Defaults window. 4.

 Click Sick/Vacation to modify the default settings then OK to close it. 5.

 Click OK to close the Employee Defaults window.6.
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Setting Up Payroll Schedules 

You can set up payroll schedules to group employees with the same pay frequency (daily, semi-monthly, bi-weekly, 

and monthly). You define how often you pay your employees, which date their paycheck is due, and which day you 

run payroll. QuickBooks calculates your upcoming payroll schedule so you can pay your employees on time.  

Using payroll schedules is a quick and convenient way to pay your employees each pay period. You set up the 

payroll schedule one time, assign the payroll schedule to the appropriate employees, and QuickBooks calculates the 

due dates for each upcoming pay period. 

You do not require payroll schedules to run payroll, however. You can run payroll without them by running 

Unscheduled Payroll or paying an employee a Termination Check. 

 To define a payroll schedule: 

 From the Employees menu, choose Add or Edit Pay Schedules.  1.

 Click the Payroll Schedule menu button at the bottom left then choose New. 2.
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 Enter a name for your payroll schedule in the What do you want to name this payroll schedule? field. 3.

 Press Tab and select the pay frequency. 4.

 Press Tab and select the pay period end date for the next period you wish to run payroll. 5.

 Press Tab and select the date that should appear on the checks for the next period you wish to run payroll. 6.

 Press Tab and select the day that should appear on the checks for the next period you wish to run payroll. 7.

 

 Click OK. 8.

 Repeat as needed to set up your pay schedules. 9.

 Close the Payroll Schedule list. 10.

Now that you’ve set up the pay schedules, you can assign each employee to the appropriate pay schedule. 

 NOTES 
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To assign employees to a schedule, choose the payroll schedule on the Payroll Compensation Info tab of the 

employee record. (You can also assign employees during the Payroll Schedule Setup process, but for this exercise 

we’ll use the employee records.) 

 To assign a pay schedule: 

 From the Employees menu, choose Employee Center. 1.

 Click the Employees tab if it is not already selected. 2.

 Right-click on the employee you wish to assign a pay schedule to then select Edit Employee. 3.

 In the Edit Employee window, choose the Payroll Info tab. 4.

 From the Payroll Schedule drop-down list, select the pay schedule you wish to assign. 5.

 Click OK. 6.

 Repeat the steps for each employee to assign the proper pay schedules. 7.

 NOTES
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Adding a New Employee 

 To add a new employee: 

 With the Employee Center displayed, click New Employee at top left. 1.

 Enter the corresponding information in the Personal, Address & Contact and Additional Info fields. 2.

 In the Payroll Info tab:  3.

 Assign the Payroll Schedule from the drop-down list.  

 Choose the earning items that apply to this employee in the Earnings grid (e.g., salary, hourly, overtime, etc.). 

 Choose any items that apply to the employee from the Additions, Deductions and Company Contributions 

grid. 

 Click on the Direct Deposit button to set up direct deposit information. 

 Click on the Taxes button to set up federal withholding and state tax information. 

 Click on the Sick/Vacation button to add any sick/vacation time accrual information. 
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 IMPORTANT: If you would like the time automatically entered from timesheets, you will want to place a check in 
the box labeled Use time data to create paychecks. 

 Enter remaining information in the Employment Info and Workers Comp tabs. 4.

 Click OK. 5.

 NOTES
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Running a Payroll Schedule 

QuickBooks lets you print payroll checks in a batch based on payroll schedules.  

 To run a paycheck schedule: 

 In the Employee Center, click the Payroll tab in the left section. 1.

 In the right section, click the Pay Employees tab. 2.

 In the Pay Employees section, choose the Biweekly pay schedule. 3.

 Click the Start Scheduled Payroll button. 4.

 Specify the last date of the Pay Period, the Check Date, and the Bank Account from which paychecks will be 5.

produced, and whether the checks are to be printed or handwritten. If they are handwritten, specify the first 

check number. 

 

 Select the employees you wish to pay by placing a check mark next to their name in the grid. 6.

 Click Continue. 7.
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 To review all paychecks, click on the Open Paycheck Detail button or, to review one paycheck, click on the 8.

employee’s name in the grid. 

 Click Save & Close to return to the Review and Create Paychecks window. 9.

 Click Create Paychecks. 10.
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QuickBooks creates a payroll check for each employee in the chosen payroll schedule (Biweekly in this case) for 

the correct net amount, showing the deductions in the voucher area. QuickBooks confirms that you have created 

the paychecks. You can then choose Print Paychecks (or Print Pay Stubs only if they are going to be handwritten 

checks). 

 

 If you don’t want to print the paychecks now, click Close. 11.

 NOTES
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Viewing the Paycheck 

QuickBooks records payroll checks in your QuickBooks bank account register (whichever bank account you selected 

when you started to pay these employees). You can see the check by going to the register, but it is easiest to view 

employee checks from the Employee Center. 

 To view the paycheck from the Employee Center: 

 From the Employees drop-down menu, click on Employee Center. 1.

 Click on the Employees tab if it isn’t already selected. 2.

 Select the name of the employee whose paycheck you want to view.  3.

 Double-click on the paycheck you want to open from the employee’s transaction list. 4.

 

 Click Save & Close to close the paycheck. 5.

 NOTES
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Printing Paychecks after Leaving Pay Employees Window 

As you know, you can print paychecks after creating them while still in the Pay Employees area. However, you do not 

have to print them at that time. You can close the payroll function and print them at any time later. 

You can print paychecks in a fashion similar to other QuickBooks checks. If you use voucher checks, QuickBooks 

prints the payroll item detail in the voucher area. If you don’t use voucher checks, you can print a paystub to give to 

your employees. 

 To print one or more paychecks after you have exited from the  

Pay Employees window: 

 From the File menu, choose Print Forms then choose Paychecks. 1.

 Select the bank account that is the source of the paychecks from the Bank Account drop-down. 2.

 Enter the starting check number from the check stock on which you are printing in the First Check Number field. 3.

 Make sure there’s a checkmark next to all employee names, and then click OK. 4.

 

 If desired, enter the text for a company message that is to appear on all pay stubs. 5.

 Click Print. 6.

 NOTES
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Printing or Emailing Pay Stubs after Leaving Pay Employees Window 

As you know, you can print pay stubs after recording paychecks to be handwritten while still in the Pay Employees 

area. However, you do not have to print them at that time. You can close the payroll function and print or email them 

at any time. 

 To print or email one or more pay stubs after you have exited from the Pay 

Employees window: 

 From the File menu, choose Print Forms then choose Pay Stubs. 1.

 Select the bank account that is the source of the paychecks from the Bank Account drop-down. 2.

 Specify a date range for listing pay stubs. 3.

 Make sure that All Employees is selected; if desired, specify one employee. 4.

 Place a checkmark next to the employees’ paychecks for which you want to print or email a pay stub. 5.

 If desired, enter the text for a company message that is to appear on all pay stubs. 6.

 

 Click either Print or Email. If you chose Email, you will see a Password Protection screen. Read the information 7.

and click OK. You would then follow the prompts to complete any missing employee email addresses. 
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 NOTES
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Paying Payroll Taxes 

If you’re about to pay taxes or other liabilities, the payroll liabilities report shows you how much to pay. Suppose you 

are ready to make a tax payment and you want to see how much you owe. 

 To create a payroll liabilities report: 

 From the Reports menu, choose Employees & Payroll then choose Payroll Liability Balances. 1.

 Select This Calendar Year in the Dates cell. 2.

 Click the drop-down menu in the Show Columns section at the top of report then select Year to change the 3.

report display. 

 

 Close the report. 4.

 NOTES
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Writing a Check for Payroll Taxes 

When it’s time to deposit payroll taxes with your deposit institution, use the Liability Check window to fill out a 

QuickBooks check. 

 To pay payroll liabilities: 

 From the Employees drop-down menu, choose Payroll Taxes and Liabilities then click Create Custom Liability 1.

Payments. 

 In the From and Through fields, enter the date range for which you are paying the liabilities. 2.

 Click OK. 3.

 Complete the information in the Pay Liabilities window to mirror the payment you making: 4.

 Ensure the proper Bank Account is selected. 

 Enter the proper Check Date. 

 Place checkmarks next to the liabilities you wish to pay. 
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 Make sure Review liability check to enter expenses/penalties is selected then click Create. 5.

 

QuickBooks will create one liability check per institution.  

 Click Save & Close to record the check. 6.

 NOTES
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Doing Payroll with QuickBooks — Review Questions 

 What is required in order for QuickBooks to calculate payroll in a real company file?  1.

_______________________________________ 

 Which two accounts are typically linked to payroll items? 2.

a. ___________________________________________________________________ 

b. ___________________________________________________________________ 

 Which of the following are QuickBooks payroll item types? 3.

a. Wage 

b. Addition 

c. Deduction 

d. All of the above 

 What report would you run to determine how much you owe in payroll taxes? 4.

________________________________________ 

 What QuickBooks feature would you use to make setting up payroll easier when a number of employees have 5.

the same hourly wage, pay period, and base deductions? 

a. Tax tables 

b. Employee defaults 

c. Payroll items 

d. Assisted payroll 

 True or false: Payroll schedules are required to run payroll in QuickBooks. 6.

a. True 

b. False 

 Payroll schedules help you do which of the following? 7.

a. Group employees with the same pay frequency 

b. Write bonus checks 

c. Prepare termination checks 

d. Pay payroll tax liabilities
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Review Activities 

 Add a salaried employee to the Employee Center. Enter the employee’s personal information, federal and state 1.

tax information, and at least one additional paycheck deduction. Assign the employee to the monthly payroll 

schedule. 

 Run the monthly payroll schedule and process a paycheck for the new employee. Then view the check in 2.

QuickBooks. Open at least one payroll liability account register to see how the paycheck changes the account’s 

balance. 

 Select one of the payroll expense accounts from the Chart of Accounts. Create a QuickReport for that expense 3.

account.
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Answers to Review Questions 

 What is required in order for QuickBooks to calculate payroll in a real company file? 1.

A subscription to a QuickBooks payroll service 

 Which two accounts are typically linked to payroll items? 2.

a. Payroll Liabilities 

b. Payroll Expenses 

 Which of the following are QuickBooks payroll item types? 3.

a. Wage 

b. Addition 

c. Deduction 

d.  All of the above 

 What report would you run to determine how much you owe in payroll taxes? 4.

Payroll Liabilities Balance 

 What QuickBooks feature would you use to make setting up payroll easier when a number of employees have 5.

the same hourly wage, pay period, and base deductions? 

a. Tax tables 

b.  Employee defaults 

c. Payroll items 

d. Assisted payroll 

 True or false: Payroll schedules are required to run payroll in QuickBooks. 6.

a. True 

b.  False. You do not require payroll schedules to run payroll, however. You can run payroll without them by 

running Unscheduled Payroll or paying an employee a Termination Check. 

 Payroll schedules help you do which of the following? 7.

a.  Group employees with the same pay frequency 

b. Write bonus checks 

c. Prepare termination checks 

d. Pay payroll tax liabilities 


